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Chapter 1

Introduction to the Labs

Classical control design is generally undertaken in the frequency domain as op-
posed to the time domain. Examination of a system in the frequency domain
allows for simpler determination of stability, through the use of phase and gain
margin metrics.

The classical control design methodology requires that a system model in the
form a transfer function be available. This is complicated by the fact that often
a suitable model may not be apparent. The following set of labs starts with a
simple system consisting of a single-pole, double-throw switch followed by an
LC �lter, proceeds through the modelling of the system and subsequently to the
design of an e�ective controller. The purpose of this system is to convert a dc
voltage at a higher level to a lower level while achieving a high power e�ciency,
typically in the 90% range. The system examined is known a Buck dc-to-dc
power converter and is widely used in industry. The endgame is to enclose this
system with negative feedback to produce an e�ective voltage regulation, in the
face of input voltage and output load variations, and so an e�ective controller
needs to be designed.

The apparent simplicity of the buck converter belies the modeling challenges
that can be brought to light. The function of the switch in the system is to
produce pulses whose width can be varied. The control of the pulse width is
undertaken by a pulse width modulator (PWM). This is inherently a nonlinear
device since a sinusoidal input produces a sinusoidally modulated pulse train
which contains spectral components not present in the input. In this case, a
so-called describing function analysis is used in modelling the system. This ap-
proach determines the magnitude and phase of the spectral component in the
output which is at the same frequency as the sinusoidal input.

Furthermore the buck converter itself is a time varying system but from basic
considerations we are able to de�ne an average model which features a number
of di�erent transfer functions of interest. In essence the system considered has
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2 CHAPTER 1. INTRODUCTION TO THE LABS

three inputs and one output (the output voltage). There is one control input
and two disturbance inputs, leading to a total of three transfer functions that
need to be modelled.

Two sets of software tools are used to help with the design and veri�cation
in these labs:

1. Matlab: As compensator design is undertaken in the frequency domain,
Bode plots are used to examine magnitude and phase responses of various
transfer functions, in particular the loop gain which is important in as-
sessing phase and gain margins. Additionally, Matlab is used to examine
time-domain simulations using the derived small-signal transfer function
models

2. PECS: This simulator permits circuit level simulation of the physical cir-
cuit, rather than just its small-signal model, and so more faithfully repre-
sents the operation of the actual system, showing large-signal e�ects such
as ripple voltage.

The software tools will be used to verify the derived transfer functions and,
in the process, help to obtain a better understanding of the system. The circuit
simulator allows one to see waveforms that closely resemble those that would be
observed in a hardware implementation as large signal e�ects can also be seen in
the simulation. Having arrived at transfer function models for a system, these
transfer functions are used in the classical control design process and can also
be used to produce time domain simulations. Thus it becomes instructive to see
how well these time domain simulations conform to the simulations obtained
from Matlab resulting from small-signal transfer function models. Becoming
further instructive when observing waveforms of the hardware implementation.

It is the aim of these series of labs to start with a simple system, that is widely
used, and to go through the whole process from understanding system operation
to the end point of reaching a design that incorporates feedback control. A big
picture set of aims for this series of labs is the following:

1. Obtain a clear understanding of the buck converter system operation

2. Obtain a suitable model of the system

3. Test the (open loop) system and verify the model.

4. Examine the e�ectiveness of a simple compensator used in (closed loop)
feedback control.

5. Design a more e�ective and albeit more complicated controller.

6. Test the improved system design and understand how and why the im-
provement has been achieved.
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In terms of the labs themselves, the titles are listed next:

� Lab 1: Introduction to a basic dc-to-dc power conversion system and the
PECS circuit simulator

� Lab 2: System Identi�cation of a 2nd Order System through Step Response

� Lab 3: System Identi�cation of the dc-to-dc Buck converter

� Lab 4: Open loop system construction and testing: the Buck dc-to-dc
voltage converter

� Lab 5: Closed Loop Feedback System - Analysis: Analysis and perfor-
mance of a closed loop dc-to-dc Buck converter system

� Lab 6: Closed Loop Feedback System - Design: Design of an e�ective
feedback compensator for a closed loop dc-to-dc converter system

Labs 1 to 3 involve the software tools in helping to understand the system
and in the process of system identi�cation i.e. discovering and verifying trans-
fer functions. Labs 4 to 6 involve hardware construction. In particular, Lab. 6
involves controller design using the asymptotic Bode plot construction method-
ology discussed in class. The design is fully veri�ed using the software tools
before implementation.

The labs have been written to be stand-alone. Consequently, su�cient back-
ground material has been included in each lab with the aim to provide su�cient
understanding required for the lab and hopefully, for the most part, obviating
the need to search elsewhere for this information.
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Chapter 2

Lab 1

Introduction to a basic dc-to-dc power con-
version system and the PECS circuit sim-
ulator

2.1 Objectives

1. To introduce a basic dc-to-dc power conversion system.

2. To introduce the PECS simulator which simulates these systems at the
circuit level. Speci�cally to gain experience with the use of the switch
(SW), pulse width modulator (MOD) and clock (CLK) elements used in
PECS and which appear in later labs.

Before using the PECS simulator, read the documentation which provides an
overview of PECS su�cient for this and subsequent labs.

2.2 Circuit #1

The circuit in Figure 2.1 switches a voltage source (V1) ON and OFF to produce
a rectangular wave (appearing across voltage port VP1) which is then �ltered
through an LC network which produces a lower dc voltage across a load (R1).
This voltage, monitored by port VP2, will be examined.

This example circuit also illustrates how clock elements can be used to control
switches.

5



6 CHAPTER 2. LAB 1

Figure 2.1: A pulse generator followed by a second order (LC) �lter, (L =
560 µH, C = 100 µF and R = 25 Ω) constitutes a dc-to-dc voltage converter.
(buck_clocks.ckt)

2.2.1 Tasks

1. Construct the circuit in Figure 2.1 in PECS. Leave the initial conditions
for L and C at zero and set the initial state of the switches to ON and
OFF for the top and bottom switches, respectively. (However, the initial
switch state is not important here but must be set to some state prior to
trying to run a simulation). Also, be aware when building the circuit that
connections to components are only made at the nodes of the components

2. Use the following simulation parameters: Final Time = 6e-2, Step Size =
2e-7, Start time = 0, End time = 6e-2. These simulation parameters will
provide a simulation of the circuit for 60 ms (as speci�ed by Final Time)
where recording of the waveform points occur every 200 ns (as speci�ed by
Step Size) as well as points occurring at switching discontinuities. At the
end of the simulation time points occurring between the Start Time and
End Time will be saved to the hard drive, which will subsequently be read
by the plotting program (PECSPLOT). For the times chosen here, points
from the whole simulation run will be saved. The relatively short Step
Size value chosen results in many points being saved which will produce
smooth output plots.

3. Run the simulation. This can be initiated from the menu items by selecting
Simulation → Run, or more conveniently from the top icon bar by clicking
the (left) script R (which appears in red).

4. Obtain a plot of the waveform across VP2, the output voltage. Looking
at your plot determine the steady state value, that is, the value of the
output voltage at the end of the simulation.

5. We would like to now look more closely at 4 or 5 cycles at the end of the
simulation. Use the Zoom feature in PECSPLOT to isolate these. Access
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this through menu items View → Zoom and then use the mouse to isolate
the time period of interest. Left click the mouse anywhere in the plotting
area at the desired starting time and drag to the desired ending time.
This can be repeated any number of times to hone into your desired time
interval.

6. Under the plot obtained in the previous task add the VP1 waveform. Do
this by accessing from the menu items: Plots → Add Plot then select the
desired out from the list of outputs shown.

7. Use the measuring feature (accessed through menu item Plots →Measure)
to �nd the peak-to-peak voltage ripple of the output voltage (VP2). Use
the right (→ ) and left (← ) arrows on the keyboard to precisely pinpoint
the maximum and minimum values of the waveform after initially placing
the measurement markers by clicking the left and right mouse buttons.

8. For the waveform of VP1, note the peak amplitude, period and pulse width
of this waveform. Determine the duty ratio of the pulse train. The duty
ratio is de�ned as the length of the high portion of the pulse, i.e. the pulse
width, divided by the period.

9. Taking the above plots into consideration, explain why you would expect
to get the steady state value you found in task (4).

2.3 Circuit #2

The circuit in Figure 2.2 produces a sawtooth voltage waveform which appears
across the capacitor (C1). This is achieved by using a constant current source
(I1) to charge the capacitor and having the capacitor rapidly discharged through
the resistor (R1) when the voltage has reached a preset level. The capacitor volt-
age and current are monitored by VP1 and IP1, respectively.

This circuit illustrates the use of the pulse width modulator element. However,
in this circuit not all features of the modulator are used. The modulator is
basically a comparator with four inputs, two of which connect externally, one
connects to a user set constant value and the last connects to an internal saw-
tooth signal. We will just use one of the external connections and the internal
constant input. (The internal sawtooth signal is not used).
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Figure 2.2: Sawtooth generator. A 1 A current source charges a 100 µF capac-
itor which is periodically quickly discharged through a 10 mΩ resistor. (saw-
tooth_3.ckt)

2.3.1 Tasks

1. Construct the circuit in Figure 2.2 in PECS. Note that for the modulator
we are setting K1 = −1 and K3 = 2, with the other modulator parameters
left untouched. The clock element has a Delay = 0 and Period = 210e-6.

2. Use the following simulation parameters: Final Time = 1e-3, Step Size =
1e-6, Start time = 0, End time = 1e-3. Run the simulation.

3. Obtain a plot of the voltage waveform across the capacitor (VP1) and
under this have a plot of the capacitor current (IP1).

4. For the waveform of VP1, note the peak amplitude and period. Given
that K1 = −1, what other factors in the circuit determines the peak
amplitude and why?

2.4 Circuit #3

We will modify the circuit in Figure 2.1 by replacing one of the clocks with a
modulator and a DC voltage source. The modulator output is connected to the
switch control terminal where the deleted clock had been. The added voltage
source's positive terminal is connected to the top input of the modulator. The
negative terminal is connected to ground. The con�guration we are seeking is
for the modulator to turn OFF the upper switch (and turn ON the lower switch).

The modulator parameter K1 associated with the top modulator input is set to
K1 = 1. (Also be sure to have K2 = 0 and K3 = 0). We will also specify the
modulator internal sawtooth to have a peak voltage of 5 V, i.e. Vpk = 5.
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Furthermore, we will change the frequency of operation of this circuit to 40 kHz.
So the period parameters of the modulator and the remaining clock should be
changed to 25 µs, i.e. set Period = 25 µs, for both these components.

Also, we will operate the circuit at 50% duty ratio. Determine the value of the
voltage source needed to achieve this, given the parameters stated above.

2.4.1 Tasks

1. Obtain a copy of your schematic. (buck_mod.ckt)

2. Repeat the tasks of Circuit #1.

3. Complete the following table.

Switching
Frequency

Duty
Ratio

Peak-to-peak
Input Voltage

to Filter

Steady State
Average

Output Voltage

Peak-to-peak
Output Voltage

Ripple
Circuit
#1

Circuit
#3

4. Explain the di�erences seen in the peak-to-peak ripple voltage values be-
tween Circuit #3 and Circuit #1. Are they in line with your expectations?
Why?
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Chapter 3

Lab 2

System Identi�cation of a 2nd Order System
through Step Response

3.1 Objectives

To observe the step response of a second order system exempli�ed by an LCR
circuit. By taking note of certain features of the response the parameters of its
transfer function will be deduced thus performing a system identi�cation.

3.2 Background

In classical control a transfer function is used to mathematically describe the
system to be controlled. The LCR network examined in this lab is an important
component of the system we will be using in subsequent labs for which we will
be designing controllers.

System identi�cation is the term used to describe the process by which a
system's transfer function is determined by suitable probing of inputs and ex-
amining the resulting output response. In this lab we will examine the step
response of a second order system to determine the parameters of its transfer
function. We will use a small-signal approach. Small signal refers to the fact
that the response will be examined for a small variation around the DC operat-
ing point which is not necessarily zero. Since the LCR circuit is linear, all small
signal models will be identical. That is, a change of operating point does not
alter the transfer function in this case. Nevertheless we will demonstrate the
small signal approach here.

Note that for an LCR network the transfer function can be easily determined
through fundamental circuit analysis, so the student will use the results obtained
through this procedure to con�rm their identi�ed model.

The LCR network examined in this lab is shown in Figure 3.1.

11
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Figure 3.1: PECS schematic of the LCR network used in this lab. The val-
ues of the components are L = 560 µH, C = 100 µF and R = 25 Ω.
(LCR_step_0.ckt)

The input is V1, the 5 V voltage source, and the output is the voltage which
appears across R1 which in PECS is monitored by the voltage port VP1. (In
PECS the presence of a voltage port dictates to the simulator the requirement
to store the voltage appearing across this port in the output variables to be
subsequently plotted).

To obtain the small-signal response, a 10% step input will be applied (V1
changes from 5V to 5.5V) and the consequential voltage changes around the
steady state value of the output voltage will be examined.

We will consider a second order transfer function, G (s) , expressed as follows:

G(s) = K
1

a2s2 + a1s+ 1

We see that there are three parameters a1, a2 and K that need to be de-
termined by the identi�cation procedure to fully characterize this system. In
the case of a second order underdamped system, that is, a system that features
complex poles. The transfer function can also be written as

G(s) = K
1(

s
ωn

)2

+ 2ξ s
ωn

+ 1

where ωn is the undamped natural frequency and ξ is the damping factor
where ξ < 1.

Consequently the output step response, c (t) , can be found to be [1]

c (t) = 1− 1√
1− ξ2

e−ξωnt cos

(
ωn

√
1− ξ2t− φ

)

where φ = tan−1

(
ξ√

1−ξ2

)
.
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Tr Tp Ts
t

c(t)

cmax

cfinal

1.02cfinal

0.98cfinal

0.1cfinal

0.9cfinal

Figure 3.2: Second-order underdamped step response

A typical step response for an underdamped second order system is shown
in Figure 3.2.

Of particular note in this response is the percentage overshoot, %OS, and
settling time, Ts.

The percentage overshoot is the maximum amount the output waveform
overshoots the steady state, or �nal value, expressed as a percentage of the �nal
value. Therefore, it is given by:

%OS =
cmax − cfinal

cfinal
× 100

The variables cmax and cfinal are shown in Figure 3.2.
On the other hand, the settling time, Ts, is the time taken from the initiation

of the step for the output waveform oscillations to remain within a band of ±2%
of the �nal value.

We will determine these two measures from a simulation and use them to
subsequently determine ωn and ξ as seen next.

Using the expression for the output step response, the percentage overshoot
can be found to be given by



14 CHAPTER 3. LAB 2

%OS = e
−
(

ξπ√
1−ξ2

)
× 100

Making ξ the subject of the equation leads to:

ξ =
−ln (%OS/100)√
π2 + ln2 (%OS/100)

To determine the settling time, Ts, we again use the expression for the output
step response c (t) given above to �nd [1]

Ts =
4

ξωn
or

ωn =
4

ξTs

Thus from the simulation plot one can determine the variables cmax, cfinal
and Ts and then utilize the above formulas to �nd ωn and ξ.

The �nal parameter to be determined is K, which represents the DC (i.e.
zero frequency) gain of the transfer function and is given by

K =
∆c

∆v
=
cfinal − c0
vfinal − v0

where cfinal and c0 represent the �nal (steady state) output level after the
step has been applied and the (steady state) value of the output before the
application of the step input, respectively. Similarly for vfinal and v0 which now
refers to the input. We will apply a 10% step input ∆v = 0.5 with vfinal = 5.5
and v0 = 5.

3.3 Tasks

3.3.1 PECS simulation

1. Enter the LCR schematic shown in Fig. 1 into PECS. Note the values of
the components: L = 560 µH, C = 100 µF and R = 25 Ω. Leave the
initial conditions for the inductor and capacitor at zero.

2. Setup the input source to achieve a 10% step of the input voltage. As
mentioned above we will change the input voltage from V 1 = 5 V to
V 1 = 5.5 V . To set this up in PECS we need to bring up the V1 element
dialog window by double clicking on the V1 symbol. Enter the initial
value of V 1 = 5 V in the Value parameter space. Next click on the Steps
button and then enter t1 = 0.11 and v1 = 5.5. This is the time at which
and value to which the input voltage V1 will change.
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3. To set up the simulation parameters for the simulation click on the menu
item Simulation → Parameters . . . This will bring up a dialog window.
Enter the following parameters: Final time = 0.2, Step Size = 1e-6, Start
Time = 0.101 and End time = 0.2.

4. Run the simulation. From the resulting plot obtained from the simulation
determine the peak overshoot value and the �nal steady state value. We
will refer to these values as c

′

max and c
′

final.

5. To determine the small signal model we will subtract the initial output
voltage level c

′

0 from the two voltage levels found in Task (4) and also
o�set the step time to zero. So that in terms of the small signal model we
have:

cmax = c
′

max − c
′

0

cfinal = c
′

final − c
′

0

6. Using the values from Task (5) determine the percentage overshoot, %OS,
and subsequently determine the damping factor, ξ, using the formulas
given above.

7. We will now determine the settling time. From your step response plot
determine the time value T

′

s at which further oscillations remain with
±2 % of the small signal �nal value. The small signal settling time Ts is
obtained by o�setting the time of the step:

T s = T
′

s − step time

8. The �nal parameter of our model K can next be determined using the
appropriate formula from above. The model is now fully speci�ed.

3.3.2 Matlab simulation � results check

We will next check the results obtained above.

9. Derive the transfer function of the LCR circuit. This is perhaps most
easily achieved using the impedance divider rule. Obtain your transfer
function in symbolic form. Identify the transfer function coe�cients K, a1
and a2 which are functions of the component values L, C and R. Complete
the following table and include it in your report:

Transfer
Function

Parameters

PECS simulation
derived values

(from Tasks 6,7&8)

From transfer
function derivation:

symbolic form

From transfer
function derivation:

evaluated
ξ
ωn

K
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10. We will now use a simulation function available in Matlab (lsim) to obtain
the step response in an analogous fashion to that obtained using PECS.
Use the following Matlab code to do this. Be sure to understand each line
of code.

Before you can run this code, enter K, a1 and a2 as functions of L, C and
R (found in the previous task) on the appropriate lines.

L = 560e-6;

C = 100e-6;

R = 25;

% enter transfer function parameters K, a1 & a2 as functions of L, C and R

K = ?; % transfer function DC gain

a1 = ?; % coefficient of s^1 in denominator polynomial

a2 = ?; % coefficient of s^2 in denominator polynomial

tf_LCR = tf(K, [a2, a1, 1]); % transfer function of the RLC network

% t is a vector of 1000 time values linearly spaced between 0 and 0.2

t = linspace(0, 0.2, 1000);

u = 5*ones(length(t), 1);

step_time = 0.11; % step the input at step_time

n = find(t >= step_time);

u(n) = u(n) + 0.5; % input containing the 10% step at step_time

y = lsim(tf_LCR,u,t); % simulate the LCR network with the desired input

figure(1)

plot(t,y)

title('Output response including the large-signal start-up transient')

% isolate the small-signal step response

c_prime_0 = y(n(1)-1); % initial output before the step

ys = y(n) - c_prime_0; % small signal output response

ts = t(n) - step_time; % small signal response times

figure(2)

plot(ts, ys)
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title('Step response')

stepinfo(ys,ts) % obtain the step response metrics

11. Compare the plots obtained from the Matlab code to that obtained using
PECS.

12. Compare the values of percentage overshoot and settling time determined
by the Matlab function stepinfo in the above Matlab code to the values
you determined form the PECS simulation. Complete the following table:

Response
Feature

From
PECS

Simulation

From
Matlab function

stepinfo

% overshoot
%OS

Settling
Time, Ts

13. In the subsequent labs we will use the LCR network as a low pass �lter
but we will include the losses of the inductor which are modelled as an
equivalent series resistance (ESR). In this task we'll qualitatively assess
the e�ect of this ESR on the transfer function.

Rederive the transfer function of the network where the inductor L is now
replaced with a series combination of the inductor L and a resistor rL.
Note: in deriving the new transfer function a short cut can be taken by
using the previously obtained transfer function and replacing any term of
sL with sL+ rL.

To more easily determine the qualitative e�ect of loss inclusion in the
transfer function, the newly obtained transfer function is simpli�ed with
the approximation:

R+ rL ≈ R

which is true when rL � R.

With the above approximation the qualitative change in the response can
be determined by inspection. State your observation on this matter. Hint:
Does it (substantially) change any of the following of the transfer func-
tion:

(a) DC gain?

(b) Undamped natural frequency?

(c) Damping factor?
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Reference:

[1] Norman S. Nise, �Control Systems Engineering�, 7th edition. Pages 173 �
176.



Chapter 4

Lab 3

System Identi�cation of the dc-to-dc Buck
converter

4.1 Objectives

The circuit simulator PECS will used to examine and characterize the steady
state operating conditions of the dc-to-dc buck converter and will aid in the
con�rmation of the system transfer functions. The open loop response to step
changes in the input voltage as well as step load changes are also examined us-
ing both PECS and Matlab. Matlab will also be used in examining the system
transfer functions. Through these simulations the student will gain a better
understanding of the operation of the buck converter circuit. The transfer func-
tions veri�ed here will be used later to design e�ective closed loop feedback
control.

4.2 Background

The LCR network examined in the previous lab is used together with a single
pole, double throw switch to derive a power processing circuit known as the
dc-to-dc Buck converter. This circuit takes a dc voltage source at the input and
transforms it to a lower value dc level at the output, whilst achieving a high
power e�ciency, typically in the 90% range. This is possible through the use of
a high frequency switch.

The schematic of the buck converter is shown below in Figure 4.1. The con-
verter schematic has been divided into 3 sections: 1) the input voltage source,
Vg, 2) the single-pole double-throw switch, and 3) the LCR network which com-

19
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prises the low-pass �lter. To more accurately model the losses in the inductor a
series resistor, rL, is included. The output load to which the power is delivered
in represented by resistance R.

The switch is operated in cyclical manner with period, Ts. At the start of
each period the switch is in its upper position which connects the input source
to the output �lter. The switch stays in this position for length of time, DT s,
where D is known as the duty ratio which takes a value 0 < D < 1. At the
end of the DT s subinterval the switch changes position to disconnect the input
source.

Figure 4.1: Dc-to-dc Buck converter.

The length of time remaining until the end of cycle isD′T s whereD
′ ≡ 1−D.

So we see that through the switching action the voltage vs appearing at the
input of the low pass �lter is a rectangular wave. The output of the �lter is
predominately a constant dc level, which corresponds to the average of the input
waveform, together with a small ripple which represents the un�ltered residuals
of the input waveform. Neglecting losses (which generally will be very small by
design) the dc output voltage is given by V = DVg. Given the range of D we
see that the output can be adjusted from 0 to Vg. Control of the output voltage
is achieved by variation of the duty ratio. To denote a time varying quantity a
lower case symbol will be used and thus a varying duty ratio is denoted by d.
Also, to further highlight a signal that represents a deviation around a steady
state average, we will use a caret `^', so that d̂ is the small signal deviation
around the average duty ratio D. Therefore, the time varying duty ratio d(t)

is comprised of an average (DC) value together with a deviation d̂ around this

average so that d = D + d̂ or alternatively, d̂ = d−D.

To achieve a varying duty ratio given a control voltage, vc, a pulse width
modulator (PWM) circuit is used, see Figure 4.2. This is comprised of an op-
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amp comparator to which one of the inputs is connected to a sawtooth waveform,
vsaw, which has a peak-to-peak amplitude of VM and period Ts. As shown in
Figure (2b) a comparison of the control voltage, vc, results in a rectangular
output waveform of period, Ts, and duty ratio, d. Combining the PWM with
the buck converter results in an open loop controlled buck converter shown in
Figure 4.3. Through the use of the PECS simulator we will examine the steady
state operation of this system.

(a)

(b)

Figure 4.2: (a) PWM comparator, (b) comparison of the control signal, vc,
with the sawtooth waveform vsaw, results in a variable pulse width rectangular
waveform used to drive the switch in the buck converter.
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Figure 4.3: Open loop controlled buck converter. The duty ratio d of the
converter is set by the control voltage, vc, via the PWM comparator.

4.3 System Transfer Functions

In a later lab we will design a closed loop controller for this system. To be
able to do this using a classical control design methodology we will �rst need
to determine important transfer functions of the system. We will consider three
transfer functions. The �rst is the control-to-output voltage transfer function.
This transfer function has two components: the duty ratio to output voltage
transfer function of the buck converter power stage, Gvd, and the pulse width
modulator transfer function, GPWM .

Control-to-output transfer function:

v̂

v̂c
= Gvd ·GPWM =

v̂

d̂
· d̂
v̂c

where the caret (^) has been used to denote a small signal signal quantity.
Note that since the modulator is nonlinear, a so-called describing function anal-
ysis method is used to determine the transfer function which ends up being a
(frequency independent) constant gain given by:

GPWM =
d̂

v̂c
=

1

VM
The control-to-output transfer function plays a very important role in con-

trol design as it forms part of the loop gain which is important to stability and
achieving good stability margins (both phase and gain).
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The other two transfer functions of the buck converter we will consider are 1)
the input voltage to output voltage transfer function and, 2) output load current
to output voltage transfer function:

1. input voltage to output voltage transfer function: Gvg = v̂
v̂g

2. output load current to output voltage transfer function: v̂
îo

= −Zout

These transfer functions quantify how variations in the input quantity at
various frequencies propagate to the output. That is, how much of an a�ect
does input voltage variations or load current variations have on the output volt-
age. Ideally, in a voltage regulator system as we are considering here, we would
like this to be zero. In this lab we will examine the Bode magnitude response to
see what level of transmission is achieved in open loop operation. With a prop-
erly designed control system incorporating feedback, these input disturbance
propagations through the system will be greatly diminished.

A block diagram model of the buck converter transfer functions which will
be used in a later lab for controller design is shown in Figure 4.4. In this lab
we'll do a partial veri�cation of these transfer functions comparing them with
previously derived results.

Figure 4.4: Block diagram model of the Buck converter along with the pulse
width modulator.

For transfer functions Gvg and Gvd considering the signal �ow from the input
through to the output of the converter, one can readily assume a form as follows

Gvg(s) =
v̂s
v̂g
· v̂
v̂s

= Kvg·GLPF (s)
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and

Gvd(s) =
v̂s

d̂
· v̂
v̂s

= Kvd·GLPF (s)

where v̂s represents the small signal voltage variations at the input of the
output �lter and where Kvg and Kvd are constant gains and GLPF (s) represents
the transfer function of the second order low pass LCR �lter which, as seen in
the previous lab, is given by

GLPF (s) =
1(

s
ωn

)2

+ 2ξ s
ωn

+ 1

Note that the damping ratio, ξ, now includes the e�ect of inductor losses, as
considered at the end of Lab. 2, by including rL, the inductor ESR (equivalent
series resistance). Constants Kvg and Kvd represent the e�ect of the switching
elements in propagating variations of the input voltage level (for Gvg) or vari-
ations of the duty ratio (for Gvd) to the input of the low pass �lter. Kvg and
Kvd represent the DC gain of the relevant transfer functions and will be found
through simulation below.

Output load current to output voltage transfer function: v̂
îo

=

−Zout:
The �nal transfer function that we'll consider is related to the output impedance

of the buck converter. Despite the presence of switching which a�ected the two
other transfer functions considered (i.e. Gvd and Gvg), the output impedance
is more straightforwardly determined as switching has no e�ect. The circuit
con�guration of the buck converter during the �rst (DT s) subinterval is seen
in Figure 4.5a, and during the remainder of the period (the D′T s interval) is
seen in the Figure 4.5b. As independent sources are nulled for determination of
impedances we can see that the output impedance, Zout, are the same during
the two subintervals and can be simply seen as a parallel connection of three
impedances such that:

Zout = (sL+ rL) ‖ 1

sC
‖ R

You will be asked to evaluate this in a latter task.
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(a) (b)

Figure 4.5: Buck converter con�guration during (a) the �rst subinterval, DT s,
and (b) the second subinterval, D′T s.

The actual transfer function of interest for us is that related to how output
current variations, îo, lead to output voltage variations, v̂. With reference to
Figure 4.6 we see that the output current io is given by

io = Io + îo

where the capitalized symbol refers to the DC steady state value and the
term with a caret (^) indicates a small-signal variation. A similar expression
can be written for the output voltage: v = V + v̂

Figure 4.6: The e�ect of output current variations,̂io, causing output voltage
variations, v̂, is quanti�ed by transfer function −Zout.

Consequently the small signal transfer function for the output impedance
Zout is given by

Zout =
v̂

−îo
and consequently the transfer function of interest v̂

îo
which we would like to

determine is given by

v̂

îo
(s) = −Zout

Note however that in the simulation (and later in the lab with the hardware
implementation), in order to achieve output current variations we will be step-
ping the load, that is, changing the load resistance between two di�erent values.
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This however causes the system transfer functions to be modi�ed somewhat.
However, as seen in Lab. 2 the major change that occurs is that of varying
the damping factor of the circuit. Nevertheless considering the convenience of
performing a step load change in the lab, the approximation considered here
will be accepted.

4.4 Tasks

1. Start-up transient: In this �rst task we will examine the start-up tran-
sient and steady state operation of the buck converter. Build in PECS the
buck converter circuit shown in Figure 4.7 below. Use simulation param-
eters: �nal time = 0.06, step size = 1e-6, start time = 0 and end time =
0.06. Run the simulation and obtain the output voltage plot. Note that
the large start-up transient is not of much interest to us here as it is a
large signal phenomenon and may be easily avoided with a slight redesign.
However, note the steady state value of the output voltage.

Figure 4.7: PECS schematic of the Buck converter with pulse width modulator.
(Lab3_1.ckt)
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2. Steady-state characteristics: We will now rerun the simulation ex-
cept we will only display the last few cycles of the response. This can be
achieved by setting the start time = 5.9881e-2 in the simulation param-
eters dialog window and rerunning the simulation. Obtain a plot of the
output voltage, the diode voltage and switch current, in three separate
plots one above the other so that relative timing relationships can be ob-
served. You can do this by �rst producing a plot of the output voltage
(VP1), then using PECSPLOT to add a plot containing the diode voltage
(VP2), this will be added under the current plot, followed subsequently
by adding the switch current (IP1) plot. (Lab3_1a.ckt)

Determine the following from the plots:

(a) The average output voltage (a visual estimate is su�cient)

(b) The peak-to-peak output voltage (this is the output voltage `ripple')

(c) The peak-to-peak diode voltage

(d) The peak inductor current,

(e) The frequency of the waveforms

(f) The duty ratio

Explain how the duty ratio is set in the circuit, given the current param-
eters of the sawtooth waveform.

3. Kvg and Step input voltage change: We will now determine constant
Kvg using a step change of the input voltage and monitoring the resulting
output voltage change, as was previously done in Lab 2. Recall from Lab
2 that

Kvg =
∆c

∆v
=
cfinal − c0
vfinal − v0

where cfinal and c0 represent the �nal (steady state) output level after the
step has been applied and the value of the output before the application of
the step input, respectively. Similarly for vfinal and v0 which now refers
to the input. We will apply a unit step input ∆v = 1 with vfinal = 11
and v0 = 10.

To set this up in PECS we will introduce two step changes in the input
source. Bring up the input source (V1) parameter dialog window click on
the Steps . . . button and set t1 = 0.025 with v1 = 11 and t2 = 0.04 with
v2 = 10. We'll also change the simulation parameter Start Time = 2.001e-
002. Obtain the simulation plot and subsequently determine Kvg using
the above equation. Also determine the maximum peak-to-peak output
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voltage deviation ∆v and steady state error, SSE. The SSE is simply the
absolute di�erence between the steady state values before and after the
input change, so this is represented by |cfinal−c0|. For an example of how
these are determined see the note below. The SSE is somewhat misnamed
in the open loop context we have here but this metric will be used later
in comparison with closed loop contexts where the steady state output
voltage is desired to remain unchanged in the presence of a disturbance
input. (Lab3_1b.ckt)

4. Kvd: To determine constant Kvd we'll use a di�erent input to that of
task (3). A sinusoidal input at a low frequency, much lower than the low
pass �lter corner frequency, will drive the input of the modulator and the
resulting sinusoidal output voltage of the converter will be monitored. To
be clear about this, determine the �lter corner frequency expressed inHz.
The sinusoidal source is attached as shown in Figure 4.8. We will use si-
nusoidal source parameters: Peak Amplitude = 0.2, Frequency = 100 and
Phase (degs) = 0. Use the same simulation parameters as in the previous
task. However, be sure to void the step changes that were introduced in
the previous task.

Run the simulation and obtain a plot of the driving sinusoid (VP3). Con-
�rm that the amplitude and frequency are as desired. Now use the add
plot feature in PECSPLOT to add the plot of the output voltage (VP1)
below the current plot. Obtain peak-to-peak measurements of the two
waveforms and determine the voltage gain. Take note of the phase rela-
tionship between the two waveforms. Are they in-phase or out-of-phase?

Considering the in�uence of the PWM gain, determine Kvd. Hint: From
previous discussions (and also from Figure 4.4) we see that the gain found
is given by

v̂

v̂c
(s) = GPWM ·Gvd = GPWM ·KvdGLPF (s)

With GPWM = 1
VM

(with VM known) and for the frequency used at
well below the low pass �lter corner frequency such that GLPF ≈ 1, the
parameter Kvd may be easily determined.
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Figure 4.8: Buck converter with pulse width modulator driven by a sinusoidal
voltage source. The added sinusoidal source has parameters: Peak Amplitude
= 0.2 volts, Frequency = 100 Hz. and Phase (degs) = 0. (Lab3_2.ckt)

5. Step load change: We next examine the output voltage change to a step
in load. This test can be easily performed for an actual circuit and so will
be undertaken subsequently on the hardware in the lab and will form the
basis for examining how well the application of feedback improves on the
open loop performance.

Alter the buck converter circuit by adding a switch which is controlled by
two clock elements as shown in Figure 4.9. Be sure to set the initial switch
state of the added switch to be in the OFF state, otherwise the simulation
will be incorrect. Also make sure no other step changes are initiated in
your circuit. Run the simulation using the simulation parameters used
before and obtain a plot of the output voltage (VP1). From this plot
determine the maximum peak-to-peak output voltage deviation, ∆v, and
steady state error, SSE.
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Figure 4.9: Buck converter with step load changes (Lab3_3.ckt)

6. Matlab

In the following tasks we will analyze the open-loop system using Matlab.
We'll examine both disturbance input transfer functions and also use Mat-
lab to perform time-domain simulations based on these transfer functions.
In the model for the PWM modulator use a peak-to-peak ramp amplitude
value of VM = 5.

Transfer functions

(a) Loop gain: Under the condition that there is no compensator, i.e.
Gc = 1 and the desired output voltage and reference voltages are,
V = 5 and Vref = 2.5, respectively so that H(s) =

Vref
V = 2.5

5 = 0.5,
determine the loop gain transfer function and use the Matlab margin
command to obtain the Bode plot of this (uncompensated) loop gain.
Have the plot display frequency in Hz. The command will also obtain
the unity gain and −180◦ phase crossover frequencies and the phase
and gain margins of the system. Make note of these in your report.
Matlab code to do this:

s = tf('s');

G_loop = ?; % input your loop gain expression as a function

of s

figure(1)

margin(G_loop)

h = gcr;
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h.AxesGrid.Xunits = 'Hz'; % display the frequency in Hz

h.AxesGrid.TitleStyle.FontSize=12; % increase font size

h.AxesGrid.XLabelStyle.FontSize=12; % for readability

h.AxesGrid.YLabelStyle.FontSize=12;

(b) Input voltage to output voltage: Using the model for the (open-
loop) input source voltage to output voltage transfer function, Gvg,
use the Matlab bodemag command to obtain the magnitude frequency
response of this transfer function (with frequency in Hz).

(c) Output current to output voltage: Using the model for the
(open-loop) output current to output voltage transfer function, −Zout,
use the Matlab bodemag command to obtain the magnitude frequency
response of this transfer function (with frequency in Hz).

Be sure to include your Matlab code for (b) and (c) in your report.
These magnitude responses show the gain at various frequencies of in-
put disturbance in propagating to the output. With the subsequent
incorporation of feedback these responses will be greatly reduced.
Ideally we would like the response to be zero across all frequencies.
Needless to say that this cannot be achieved perfectly in practice.

Open-loop simulations:

Note that the following simulations obtained using Matlab are based
on the small-signal model only. Thus DC conditions and large sig-
nal e�ects are not modelled and consequently do not show up in the
simulations. In order to more easily compare the Matlab simulations
with those obtained from PECS we will simply add the average con-
verter output voltage to the response obtained from Matlab.

(d) Input voltage step response: Use the transfer function obtained
above for Gvg to obtain the response to 10% step input voltage
change. Since the nominal input voltage level is 10 V, we there-
fore will use a unit step input. Use the Matlab lsim command to
perform this simulation. Determine the maximum peak-to-peak out-
put voltage deviation, ∆v, and steady state error, SSE. Matlab code
to do this:

Vg = 10;

D = 0.5;

V = D*Vg;

s = tf('s');

Gvg = ? ; % input your expression for Gvg as a function of s

t = linspace(0.02, 0.06, 1000);
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u = zeros(size(t));

ind = find(t>=0.025 & t<=0.04);% step is between 0.025<t<0.04

Vg_diff = 1;

u(ind) = u(ind) + Vg_diff;% form input vector containing the step

figure(2)

y = lsim(Gvg, u, t); % simulate the step response

plot(t,y+V) % add steady state voltage to the output and plot it

del_v = max(y) - min(y) % peak-to-peak voltage deviation

SSE = y(ind(end)) % steady state error

(e) Output current step response: Based on discussion in a prior
section of this lab, determine the converter output impedance, Zout.
We will use the transfer function −Zout to obtain the response for a
step load change. In order for this to mimic the practical circuit as
closely as possible you will �rst determine the value of the current
step involved. Taking note of the load switching circuit shown in
Fig. 3, we see that the load switches between 25 ohm and 5 ohms.
This results in the output current switching between Io_1 = V

25 and

Io_2 = V
5 , where we have assumed that the output voltage does not

change appreciably. Thus the current step is Io_diff = Io_2 − Io_1.

Use the Matlab lsim command to perform a step response simula-
tion to this load step. Determine the maximum peak-to-peak output
voltage deviation, ∆v, and steady state error, SSE. Matlab code to
do this:

s = tf('s');

Zout = ? ; % input your expression for Zout as a function of s

Vg = 10;

D = 0.5;

V = D*Vg;

Io_1 = V/25; % load current before step. (25 ohm load)

Io_2 = V/5; % load current after step. (5 ohm load)

Io_diff = Io_2 - Io_1; % current step

t = linspace(0.02, 0.06, 1000);

u = zeros(size(t));

ind = find(t>=0.025 & t<=0.04);% step is between 0.025<t<0.04

u(ind) = u(ind) + Io_diff;

figure(3)
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y = lsim(-Zout, u, t);

plot(t,y+V)

del_v = max(y) - min(y)

SSE = y(ind(end))

4.5 Note

Computing maximum peak-to-peak output voltage deviation, ∆v, and
steady state error, SSE :

With reference to Figure 4.10 we see that the output voltage before the
input step is at 5 V (see value at time = 0.2646). The input step occurs at time
0.30 causing the output to oscillate between max and min values of 5.996 and
3.199 before settling to new steady state output value of 4.816. Subsequently
the input step reverts to its initial value at time 0.34 resulting in oscillations
occurring between max and min values of 6.617 and 3.82. The quantity ∆v is
determined as the di�erence between the maximum and minimum deviations
in the step response, so that ∆v = 6.617 − 3.199 = 3.418 V. The SSE (steady
state error) is determined as the di�erence in the two steady state values, so
that SSE = 5.0− 4.816 = 0.1840 V.

Figure 4.10: The plot shows the output voltage response to an input step change.
This response is used to determine the maximum peak-to-peak output voltage
deviation, ∆v, and steady state error, SSE.
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4.6 Results

Be sure to include a summary of your results by completing the following tables
and including them in your report.

Transfer function DC gains:

From PECS:
Tasks (3) and (4)

From model:
Symbolic Model

From model:
Symbolic formula evaluated

Kvg

Kvd

Uncompensated stability margins and associated frequencies, from Task 6a:

Gain Margin
Phase Crossover

Frequency
Phase Margin

Gain Crossover
Frequency

Step response characteristics:

PECS
Tasks (3) and (5)

Matlab
Tasks (6d) and (6e)

vg step: ∆v
vg step: SSE
iout step: ∆v
iout step: SSE

Provide answers to the following questions regarding the step response re-
sults:

1. Comparison of the results for ∆v for iout step changes obtained from
PECS and Matlab di�er more than one might expect. Provide a reason
why. (Hint: look closely to how this is modelled).

2. From basic circuit considerations provide a simple symbolic expression for
the SSE quantity found for a step in input voltage, vg.

4.7 Postscript

In this lab we have developed a linear model for the buck converter system which
resulted in deriving three transfer functions: 1)Gvd, 2)Gvg and 3) −Zout. These
transfer functions quantify how the duty ratio control input, d̂, and other (dis-
turbance) inputs, v̂g and îo, cause output voltage variations, v̂. The pulse width
modulator `describing function' is much more involved to determine despite the
simplicity of the �nal result being a constant, which was given here without
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further discussion. Together with transfer function, Gvd, the control voltage,
v̂c, to output, v̂, transfer function can be determined.

Through simulations, both at a circuit level (using PECS) and at a transfer
function level (using Matlab), the model has been con�rmed.

In subsequent labs a hardware implementation of these circuits will be ex-
amined with the �nal goal of designing an e�ective compensator for closed loop
feedback control.
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Chapter 5

Lab 4

Open loop system construction and test-
ing: the Buck dc-to-dc converter

5.1 Objectives

To build and examine the operation of an open loop dc-to-dc buck converter.
This system converts a dc voltage level to a lower dc voltage level at high power
e�ciency. We will examine the performance of this circuit to step load changes.
This will establish a baseline level of performance by which the closed loop
designs of later labs will be judged.

5.2 Background

The open loop dc-to-dc buck converter circuit to be constructed is shown in
Figure 5.1 where the individual function blocks are identi�ed. There are several
function blocks that are discussed below:

1. Buck converter power stage: This contains the LC �lter and load re-
sistance as well as the switches. The single-pole, double-throw switch of
the buck converter is implemented using a mosfet and diode combination.

To minimize losses and damping in the buck converter, the components
used there should all be high quality. This translates for each component
to mean the following:

(a) Buck converter mosfet: high power mosfet with low RDS(on) value.

(b) Diode: this needs to be fast reverse recovery power diode. The diode
that has been speci�ed is a Schottky diode which features a very

37
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Figure 5.1: Schematic of the open-loop dc-to-dc buck converter.
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fast recovery time as well as a lower voltage conduction drop than a
silicon diode.

(c) Inductor: this needs to be a power inductor which can handle an
appreciable DC current �ow. It should also have a low equivalent
series resistance (ESR).

(d) Capacitor: this should be a high quality capacitor with a low ESR.

Note also that the load resistances need to handle the power that they
will dissipate, so the speci�ed power rating needs to be observed.

Further discussion concerning components appears at the end of this lab.
Bearing the above in mind, arbitrary substitution of components is to be
avoided.

2. Load switching mosfet: The load will be switched between two di�erent
values in order to examine the stepped-load performance of the converter.
Switching of the load is done by turning ON and OFF a mosfet which
is in parallel with a portion of the load. This mosfet is controlled by an
external square wave generator.

3. Mosfet driver: this is required in order to drive the mosfet with sharp
step transitions at a high frequency. It interfaces between the comparator
and the buck converter power mosfet.

4. DC + superimposed AC block: this is simply a variable resistive volt-
age divider which provides an adjustable DC voltage level. This is fed to
the comparator (discussed next).

The adjustable DC allows for the duty ratio, which controls the buck
converter, to be set. An external AC signal may be fed into the circuit
which superimposes the AC on top of the DC level. The resulting AC
modulated duty ratio will be see in the buck converter output voltage.

5. Comparator: The comparator and the sawtooth generator (discussed
next) together form the pulse width modulator (PWM). As discussed
above, in the present circuit a DC voltage is applied to the inverting
input of the comparator and a sawtooth waveform is applied to the non-
inverting input. As the sawtooth transitions past the DC voltage level, the
comparator will change state producing a rectangular output waveform.
The duty ratio of this waveform can be changed by adjusting the DC level
using the potentiometer voltage divider.

6. Sawtooth generator: A constant current source (comprising transistor
Q5, zener diode D2 and resistors R5, R6 and VR2 in Figure 5.1 is used to
charge a capacitor (C4 in Figure 5.1) resulting in a voltage ramp appear-
ing across the capacitor. At a predetermined voltage across the capacitor
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the LM555 circuit discharges it. This process is ongoing producing a saw-
tooth waveform. The level of the constant current can be adjusted (by
varying VR2 in Figure 5.1) which adjusts the rate at which the threshold
discharge voltage is reached thus varying the frequency of the resulting
sawtooth.

5.3 Tasks

We will construct the circuit in a step-by-step fashion and test each function
block as it is constructed. Note that we will be using two di�erent power supply
sources. A 10 V high current source is needed for the buck converter and a 15
V low current source will power the rest of the circuit. A number of tasks below
ask that you take a screenshot (or a photo) of the waveform(s) appearing on the
oscilloscope. If this is not possible you'll need to neatly sketch the waveform
providing voltage level and time period annotations.

1. Construct the sawtooth generator:

(a) After you assemble the circuit, use an oscilloscope to monitor the
sawtooth voltage waveform across the charging capacitor, C4. Adjust
the potentiometer (VR2) to obtain a frequency of 40 kHz.

(b) Take a screenshot of the sawtooth waveform. What are the mini-
mum and maximum voltage levels of the sawtooth? The peak-to-
peak voltage di�erence represents VM in our modelling of the PWM
modulator.

2. Construct the comparator and DC + superimposed AC circuits:

(a) Assemble the circuit. At this time we will open jumper J1 and
close jumper J2. Also the just-constructed sawtooth generator signal
should be connected to the non-inverting input of the comparator.

(b) Based on the sawtooth waveform you've just observed, what range of
duty ratios are you able to achieve by varying the Duty Ratio Adjust-
ment potentiometer (VR1) from one extreme to the other? Show how
you can calculate this. Con�rm your results in the lab. Note that
the duty ratio is de�ned by the length of the high time of the pulse
that appears at the input of the output �lter as a ratio of the period.
Due to use of a p-channel mosfet in the buck converter power stage a
low comparator output corresponds to the mosfet turning ON, which
produces the high portion of the pulse, the time interval of which
determines the duty ratio, as was just mentioned. Therefore, use
this time interval of the low voltage level at the comparator output
divided by the square wave period as the duty ratio value.

(c) Use an oscilloscope to monitor the output of the LM311 (pin 7). Vary
the duty-ratio adjustment potentiometer (VR1) to set a 50% duty
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ratio. Check that you have 15 V peak-to-peak square wave. (If so
your comparator circuit is functioning properly). Take a screenshot
of this waveform.

3. Construct the mosfet driver:

(a) Connect the two transistors and resistor of the mosfet driver to the
10 V power supply. We will connect the just-constructed comparator
circuit by closing jumper J1 and opening jumper J2.

(b) Use an oscilloscope to monitor the voltage at the common emitter
connection of the two transistors. Check that you are seeing a 10 V
peak-to-peak square wave. (If so, your driver circuit is functioning
properly). Take a screenshot of this waveform.

4. Construct the Buck converter:

(a) Assemble the Buck converter. (Do not add the load switching mos-
fet at this time). At this point the whole circuit should be fully
functional (without load switching).

(b) Use an oscilloscope to observe the waveform across the switching
diode. Check that you are seeing a 10 V peak-to-peak square wave.
Also, you should see sharp rising and falling transitions. (If so, your
power mosfet is likely switching properly). Take a photo of this
voltage waveform.

(c) To further verify proper functioning of your power stage, use the
oscilloscope to monitor the voltage across the output load, the series
combination of the 5 Ω and 20 Ω resistors. Determine its DC value. Is
this in accordance with the duty ratio value that you had previously
set up?

(d) For even further veri�cation of the proper operation of the circuit we
will inject a small sinusoidal waveform that will modulate the duty
ratio, the e�ect of which will be seen in output voltage. Recall that
this was done previously via PECS simulation in Lab 3. You'll be
now able to con�rm the results obtained there.

To proceed, connect a small-amplitude, low-frequency sinusoidal volt-
age (100 Hz or lower) to the Vi terminal which feeds into the DC +
superimposed AC block. This will superimpose an AC variation on
top of the DC voltage appearing at the inverting terminal of the com-
parator. The frequency is chosen to be much below the LC resonant
frequency of the output �lter, fo = 1

2π
√
LC

= 673Hz. The ampli-

tude should be chosen to be large enough to facilitate measurement
of the resulting signal across the output, and no larger so as to not
violate the small-signal assumption. Display the input and output
signals (as de�ned next) on the oscilloscope and take a screenshot.
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Using the oscilloscope measure the peak-to-peak amplitude of the si-
nusoidal variation appearing across the converter load. This is the
output signal. Now with the oscilloscope, measure the peak-to-peak
amplitude of the sinusoid at the inverting input of the comparator
(pin 3 of the LM311). This is the input signal. Determine the ratio of
the amplitudes of the sinusoids: output amplitude/input amplitude.
Can you say what this number represents with respect to the control
to output transfer function and what its components are?

Also take note of the phase di�erence between the output and the
input. Is the output in-phase or out-of-phase with the input at the
chosen frequency? In this task we simply want to verify whether the
signal is being inverted in this signal path. In the next lab we will be
closing the loop with negative feedback via a compensator so we will
need to determine whether the compensator will need to provide the
180

◦
phase inversion. What is your assessment of this?

5. Switched load performance:

At the present point you should have a fully functional dc-to-dc converter
which is converting the 10 V DC input to a 5 V DC output across the
series resistor combination of 5 Ω and 20 Ω (for a total of 25 Ω) load.

(a) We will now attach the load switching mosfet circuit and further
connect it to a square wave generator which provides a 5 V amplitude
signal at a low frequency. The square wave lower voltage level should
be 0 V and the higher voltage level should be 5 V. The frequency
should be adjusted so as to see the full settled output response of the
converter. (A square wave frequency in the range of 50 Hz to 100 Hz
should be �ne). The mosfet will be turning ON and OFF shorting
out the 20 Ω resistor in the load. Thus the output current will be
pulsing between

(
5 V
25 Ω =

)
0.2 A and

(
5 V
5 Ω =

)
1 A (ignoring output

voltage changes).

(b) The varying load current will cause the output voltage to vary. Take
a screenshot of the output voltage response. Determine the maximum
peak-to-peak output voltage deviation, ∆v, and the steady state er-
ror, SSE. If necessary, please see the note in Lab. 3 concerning how
to determine these quantities.

5.4 Results

(a) Complete the following tables to summarize your waveform observa-
tions in the previous tasks.

Tabulate your results from Task 1b:



5.4. RESULTS 43

Minimum
Value

Maximum
Value

VM
= pk-pk voltage

Sawtooth
(Task 1b)

Tabulate your results from Task 2b:

Task 2b Duty Ratio (D)
Min. D: formula to
determine min. D
Min. D: formula
evaluated
Min. D: measured
in lab
Max. D: formula to
determine max. D
Max. D: formula
evaluated
Max. D: measured
in lab

Tabulate your results from Task 4d:

Input Sine Voltage
(Task 4d)

pk-to-pk =

Output Sine Voltage
(Task 4d)

pk-to-pk =

Output/Input Ratio
(Task 4d)

(b) To see how well our prior simulations conform to practice complete
the following table:

From Hardware
from

Lab 4 (this lab), Task 5b

Using PECS
from

Lab 3, Task 5

Using Matlab
from

Lab 3, Task 6e
∆v
SSE

(c) Write your observations concerning the io step response results and
provide explanations for any discrepancies you see.
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5.5 Notes - Buck converter components:

As mentioned earlier, in order to produce a high level of performance, and also
to be able to use a system model that is not overly complicated by the need
to include many parasitic elements, the components of the buck converter need
to be of high quality. We'll take a look at the speci�c components used in our
circuit and take note of some important characteristics seen in their datasheets.

Capacitor: The 100 µF �lter capacitor is manufactured by Kemet and has
part number A758EK107M1AAAE016. It is polymer aluminum and features
a very low ESR (equivalent series resistance) of just 16 mΩ. Generally, the
ESR together with the capacitor forms a zero in the transfer functions; how-
ever, given these characteristics for the capacitor the zero is positioned at a

frequency of approximately
(

1
2πRESRC

≈
)

100 kHz. This is well beyond the

loop bandwidth of our system and consequently may be neglected, as we have
done in these labs. The low ESR also minimizes the voltage ripple appearing in
the output.

Inductor: The 560 µH inductor is manufactured by Bourns Inc. and has part
number 2200HT-561-V-RC. It has a maximum DC resistance of 230 mΩ. We
have used this value in our modeling. This is the only parasitic element that
is included in our system model. This was done as it has appreciable e�ect on
load regulation, i.e. output voltage variation due to load changes.

Diode: The diode used is manufactured by Sanken and has part number RA
13V1. It is a Schottky diode with a fast switching recovery time of less than
500 ns, and has a forward conduction drop of just 360 mV@ 2 A. This compares
very favorably compared to the 0.6 V to 0.7 V conduction drop of the average
silicon diode. Thus further minimizing parasitic e�ects.

Mosfet: The IRF9530 mosfet is available from a number of di�erent manufac-
tures. It has a maximum RDS(on) of 0.30 Ω. Its n-channel complement, the
IRF530 mosfet, used to switch the load, has a maximum RDS(on) of 0.16 Ω.

Load resistors: The values and power ratings of the load resistances are
5 Ω, 5 Wand 20 Ω, 2 W .
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Lab 5

Closed-Loop Feedback System - Analysis:
Analysis and performance of a closed loop
dc-to-dc Buck converter system

6.1 Objectives

To build and examine the performance of a closed-loop dc-to-dc buck voltage
regulator. A simple compensator is provided. (In the next lab this will be
replaced by a better performing, albeit more complicated, compensator designed
by the student). First an analysis of the system using the closed loop transfer
functions is examined. Subsequently a simulation of the closed loop system is
performed both at the transfer function level, using Matlab, and at the circuit
level, using PECS. Having �rst gained an appreciation of the operation of the
circuit and the performance of the system through simulation, next a hardware
implementation is built and performance is examined in the laboratory and
results are compared with those previously obtained by simulation.

6.2 Background

The dc-to-dc converter together with the PWM modulator, introduced in Lab.
3, is now operated in closed loop as depicted in Figure 6.1. As seen in this
�gure, the output voltage (the controlled variable) is scaled (via the resistive
divider comprising Ra and Rb), fed back and compared with a reference voltage
producing an error signal. This signal is next processed through the feedback
compensator (also known as a frequency compensator) which produces the con-
trol signal to the converter via the PWM modulator.
The output voltage of the system, v, is a function of its three inputs: 1) duty
ratio, d, 2) input source voltage, vg, and, 3) load current, io. So that

45
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Figure 6.1: Closed loop dc-to-dc buck converter voltage regulator

Figure 6.2: Closed loop dc-to-dc buck converter voltage regulator block diagram
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v = f(d, vg, io)

As this function is nonlinear, a linearized model is developed through a Taylor se-
ries expansion around a steady state operating point given by V = f(D,Vg, Io),
where capitalized variables refer to steady state values. This results in the
following small signal model:

v̂ = Gvd (s) d̂+Gvg (s) v̂g − Zout (s) îo

where the caret `^' indicates a small variation around the relevant steady state
variable. This represents the power stage small-signal model, and is shown
in block diagram form in Figure 6.2. Also shown in this �gure are the blocks
representing the modulator, compensator and feedback gain. This forms a closed
loop feedback system. With the feedback loop closed we have

d̂ =
Gc (s)

VM
(v̂ref −H (s) v̂)

where v̂ref is the reference voltage (which in a regulator system is constant, so
later we will set v̂ref = 0). When substituted and rearranged, the above results
in:

v̂ = Gvref_CL(s)v̂ref +Gvg_CL(s)v̂g − Zout_CL(s)̂io

where

Gvref_CL(s) =
1

H(s)

T (s)

1 + T (s)

Gvg_CL(s) =
Gvg(s)

1 + T (s)

Zout_CL (s) =
Zout(s)

1 + T (s)

Where T (s) is the loop gain given by:

T (s) =
1

VM
·Gc(s) ·Gvd(s) ·H(s)

Alternatively, these closed loop transfer functions could also have been straight-
forwardly derived by a block diagram reduction of Figure 6.2.

The open loop transfer functions for the converter and modulator are summa-
rized in Table 6.1.
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Table 6.1: Transfer Functions of the buck converter and modulator

∆ (s) = 1 + s
ω0Q

+
(
s
ω0

)2

, Q =
√
LC

rLC+L
R

, ω0 = 1√
LC

Gvd ,
v̂

d̂

Vg
∆(s)

Gvg ,
v̂

v̂g

D

∆(s)

−Zout ,
v̂

îo
−

rL

(
1 + sL

rL

)
∆(s)

GPWM ,
d̂

v̂c

1

VM

H(s)− feedback gain
Rb

Ra +Rb

The system to be analyzed and built in this lab is shown in Figure 6.4. This
is a modi�cation of the open loop circuit examined in Lab. 4. A number of
elements have been added to the open-loop circuit:

1. Compensator: this is added to shape the loop gain to assure stability
and to obtain adequate phase and gain margins.

2. Divider: this is a resistive divider which takes the output converter volt-
age and divides it to produce a lower level voltage which will be compared
to a suitable reference voltage. From a control theoretic point of view, this
is denoted as the feedback gain in the standard non-unity gain feedback
block diagram.

3. Voltage reference: this is the input of a feedback system. Since the
system here is a voltage regulator, the input is a constant voltage. This is
achieved using a Zener diode.

The compensator used in this lab is the integral compensator, which is shown
in its usual form in Figure 6.3. The transfer function for this compensator is
given by:

Gc(s) = − 1

RCs
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We will add this transfer function and that of the resistive divider, (which
corresponds to the H (s) block in Figure 6.2), in closing the loop around the
system. The resulting compensated loop gain transfer function of the system
will be examined.

Figure 6.3: Integral compensator implementation, Gc (s) = −Kis , where Ki =
1
RC

6.3 Tasks

6.3.1 Pre-Lab

In the following tasks we will analyze the closed-loop system. For the PWM
modulator model use the peak-to-peak ramp amplitude value VM that you mea-
sured as part of Lab. 4.

1. Loop gain Analysis:

(a) Asymptotic Bode plots: Sketch and annotate the asymptotic
Bode plot (magnitude and phase) for each of the following. The
annotations should comprise labeling of break frequencies, slopes of
sloping lines, gains of sloping lines and gain and phase levels of zero
slope lines.

i. Open-loop system, i.e. product of all the transfer functions in the
loop, except set Gc (s) = 1. Be sure to use a Q value that takes
account of the ESR of the inductor. Don't forget to annotate
the sketch.

ii. Compensator transfer function. Here the integral controller has
transfer function, Gc (s) = −Kis , where Ki = 1

RC . Don't forget
to annotate the sketch.

iii. Construct the asymptotic Bode plot using (i) and (ii) for the
compensated loop gain. Do this by graphically combining the
plots of (i) and (ii). Don't forget to annotate the sketch. Using
this plot determine the phase margin and unity gain crossover
frequency, and the gain margin (in dB) and the associated −180◦

phase crossover frequency.
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Figure 6.4: Schematic of the closed-loop voltage regulator system.
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(b) Routh-Hurwitz: Derive the compensated loop gain, T, with an
integral controller with transfer function, Gc (s) = −Kis . Use the
Routh-Hurwitz test to �nd the range of values of Ki for which the
loop is stable. To determine the closed loop stability using Routh-
Hurwitz you'll need to examine the coe�cients of the denominator
polynomial of transfer function 1

1+T or T
1+T . These transfer func-

tions appear as part of the closed loop transfer functions previously
derived. State the value of Ki used in the schematic of Fig. 3.

2. Closed-loop transfer functions - Matlab:

(a) Loop gain: Use the Matlab margin command to obtain the Bode
plot of the compensated loop gain. Have the plot display frequency
in Hz. This command will also determine the phase and gain mar-
gins of the system, and the associated frequencies, i.e. unity gain
crossover frequency and the −180◦ phase crossover frequency, re-
spectively. These should con�rm the numbers that you determined
in Task (1.a.iii). Make note of these in your report.

(b) Input voltage to output voltage: Determine the closed-loop in-
put source voltage to output voltage transfer function which we'll
denote as: Gvg_CL. Use the Matlab bodemag command to obtain
the magnitude frequency response of this transfer function. On the
same plot show the open loop transfer function, Gvg. Show the re-
sponse in Hz over a frequency range of 1 Hz to 10 kHz.

(c) Output current to output voltage: Determine the closed-loop
output current to output voltage transfer function. Since this is the
negative of the output impedance, we will denote it as −Zout_CL. Use
the Matlab bodemag command to obtain the magnitude frequency re-
sponse of this transfer function. On the same plot show the open loop
transfer function, −Zout. Show the response in Hz over a frequency
range of 1 Hz to 10 kHz.

3. Closed-loop simulations � Matlab:

Note that the following simulations obtained using Matlab are based on
the small-signal model only. Thus DC conditions and large signal e�ects
are not modelled and so consequently do not show up in the simulations.
However it is recommended that the steady state output voltage be added
to the responses below (as was done in Lab. 3), so that an easy comparison
can be done with the PECS simulations in Task 4.

(a) Input voltage step response: Use the transfer function previously
obtained for Gvg_CL to obtain the output step response for a 10%
input voltage step, which for a nominal input voltage of 10 V cor-
responds to a unit step. If required, refer to Lab. 3 to see how to
use the Matlab lsim command to perform a unit step response sim-
ulation. Obtain the step response plot and determine the maximum
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peak-to-peak output voltage deviation, ∆v, and steady state error,
SSE.

(b) Output current step response: Use the transfer function previ-
ously obtained for −Zout_CL to determine the step response for a
step load change. If required, refer to Lab. 3 to see how to determine
the current load step value and to see how it can be used with the
Matlab lsim command to perform step response simulation. Obtain
the step response plot and determine the maximum peak-to-peak
output voltage deviation, ∆v, and steady state error, SSE.

4. Closed-loop simulations � PECS: We will now use the circuit simu-
lator to obtain the same two closed loop responses discussed in Task (3)
above. The PECS simulations will show DC conditions and large signal
e�ects, such as ripple, not available using the Matlab small-signal models.

(a) Input voltage step response: Con�gure a PECS schematic to
obtain the output voltage step response for the input voltage stepping
from 10 V (the nominal input voltage level) to 11 V. Obtain the
step response plot and determine the maximum peak-to-peak output
voltage deviation, ∆v, and steady state error, SSE.

(b) Output current step response: Con�gure a PECS schematic to
obtain the output step response to a switched load, as was previously
undertaken in Lab. 3. Obtain the step response plot and determine
the maximum peak-to-peak output voltage deviation, ∆v, and steady
state error, SSE.

6.3.2 In the Lab

5. Build the circuit:

(a) Check circuit operation: Now that the simulations of the previous
tasks have been performed, hopefully you've obtained some greater
appreciation for the functioning and the performance of the closed
loop regulator system. We will now build the system as shown in
Figure 6.4. Before performing the load switching test (to be discussed
next) make sure your system is functioning properly by checking
various voltage waveforms in the circuit. These may include the
sawtooth waveform, the voltage waveform across the switching diode
(i.e. at the input of the LC �lter) as well as the output voltage. The
output voltage level should be at a nominal value of 5 V.

(b) Output current step response: For simplicity in the following
we will restrict ourselves in the lab to only obtaining the step load
response.

Connect a square wave generator which produces a 5 V amplitude
signal to the load switching mosfet as shown in the schematic. While
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monitoring the output voltage response adjust the frequency of the
applied signal to a maximum required to fully see the evolving re-
sponse before the next switching event occurs. A frequency in the
range of 50 Hz to 100 Hz should be adequate. Take a screen shot of
this response. Determine the maximum peak-to-peak output voltage
deviation, ∆v, and steady state error, SSE.

6.3.3 Post-Lab

6. In your report include the following tables to succinctly summarize your
results.

(a) In the following table, summarize results of your loop analysis ob-
tained by

i. the asymptotic Bode plot method, and,

ii. Matlab con�rmation.

Phase Margin
φPM

(degrees)

Unity Gain
Crossover, fc

(kHz)

Gain Margin
GGM

(dB)

Phase
Crossover, fGM

(kHz)
Asymptotes
Matlab

(b) To compare the step response results obtained by the three ap-
proaches summarize them in the following table:

Matlab
Simulation

PECS
Simulation

Lab

vg: step ∆v Unavailable
vg: step SSE Unavailable
iout: step ∆v
iout: step SSE

(c) Write your observations concerning these results.

7. The next two tasks (i.e. Tasks (8) and (9)) are optional. Consider doing
either one or both. They examine the performance of the system using
alternative compensators. In Task (8), the performance of a proportional
compensator i.e. Gc (s) = −Kp, where Kp is a constant, is examined. In

Task (9), a lead compensator, where Gc (s) = −K 1+ s
ωz

1+ s
ωp

where ωz and ωp

are zero and pole frequencies, respectively, such that ωz < ωp, is examined.

The performance with these controllers feature one striking qualitative
di�erence with that of the integral controller for the stepped input tests
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undertaken here. Can you state what that is? (Hint: do a quick simula-
tion using PECS, using the compensator circuits below along with the R
and C values suggested there, and see what that is.)

6.4 Optional Tasks - Alternative compensators

Having already tackled tasks (1) to (6) for the case of integral control, it
is straightforward to examine the case of proportional and lead control.

6.4.1 Proportional Control

8. The proportional controller is shown in Figure 6.5. In PECS and in the
hardware, one needs only to swap out the capacitor of the integral con-
troller with an appropriately sized resistor. To achieve a gain of ten, we
will set R2 = 1MΩ, (given that R1 = 100kΩ).

Repeat tasks (1) to (6), to examine the performance of a proportional
controller.

Figure 6.5: Proportional compensator implementation, Gc(s) = −Kp, where
Kp = R2

R1

6.4.2 Lead Control

9. The lead controller is shown in Figure 6.6.

Figure 6.6: Lead compensation implementation, Gc(s) = −K 1+ s
ωz

1+ s
ωp

, for ωz < ωp.
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The zero and pole frequencies are given by ωz = 1
R1C1

and ωp = 1
R2C2

and

K = R2

R1
. Use R1 = 22 kΩ, R2 = 820 kΩ, C1 = 4.7 nF and C2 = 12 pF.

Repeat tasks (1) to (6), to examine the performance of the lead controller.

6.5 Note

The op-amp used in the compensator, i.e. the CA3140, was chosen since, as
stated in the datasheet, it has a �common mode input voltage capability down
to 0.5 V below the negative supply terminal� which is more than adequate for
our use of a 2.5 V reference voltage at one of its input terminals. Other op-amps
do not fair so well so one needs to bear this in mind in seeking a substitute for
this device.
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Chapter 7

Lab 6

Closed Loop Feedback System - Design:
Design of an e�ective feedback compen-
sator for a closed loop dc-to-dc converter
system

7.1 Objectives

This is the �nal in this series of six labs culminating in the design of an e�ective
frequency compensator for a practical feedback system. There are four main
objectives:

1. Design of a feedback compensator using the asymptotic Bode plot method-
ology.

2. Veri�cation of the design before implementation in the lab. This is done
both at the transfer function level using Matlab, and at the circuit level
using PECS.

3. Building the complete feedback system in the lab and subsequently testing
it.

4. To appreciate the e�ectiveness of the design, a comparison with previous
implementations is made. Three implementations are compared:

(a) Open loop (Lab 4)

(b) Closed loop with integral compensation (Lab. 5)

(c) Closed loop with `dominant pole plus lead' compensation (Lab. 6
(this lab))

57
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7.2 Background

For this lab we start with the circuit implementation of Lab. 5. The integral
compensator in the Lab 5 circuit will be replaced with a `dominant pole plus
lead' compensator that will be designed in this lab. The compensator has a
transfer function given by:

Gc (s) = −
ω0

(
1 + s

ω1

)(
1 + s

ω2

)
s
(

1 + s
ω3

)
A circuit implementation of this transfer function is shown in Figure 7.1. This
compensator enables the loop gain to exhibit a very high gain at low frequencies
as well as an extended bandwidth while achieving desired phase and gain mar-
gins. The design of the compensator is to be undertaken using the asymptotic
Bode plot method which straightforwardly approaches the problem of e�ective
loop shaping.

Figure 7.1: `Dominant pole plus lead' compensator to be designed in this lab.

The poles and zeros of the compensator in terms of component values are given
by:

ω0 =
1

R1(C2 + C3)

ω1 =
1

R2C2

ω2 =
1

R1C1

ω3 =
1

R2
C2C3

C2+C3

In Lab. 5 we implemented the integral controller where the compensator transfer
function is given by (ignoring sign) Gc (s) = Ki

s . Also, (as an optional task),
an opportunity was given to examine proportional control where Gc (s) = Kp.
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These compensators may be seen as speci�c components of the three term PID
(Proportional � Integral � Derivative) compensators. If we consider the general
PID compensator we have

Gc (s) = Kp +
Ki

s
+Kds

where the third (derivative) term has now been added. Note however that this
third term, on its own, is non-causal and therefore not realizable. To remedy
this, it is customary to associate a high frequency pole with this term. This
results in the following for the total PID compensator

Gc (s) = Kp +
Ki

s
+

Kds

1 + s
a

where a represents the added high frequency pole. The above may be arranged
in quotient form

Gc (s) =
(Kp+aKd)s

2 + (aKp +Ki) s+ aKi

s(s+ a)

Thus the general PID compensator is comprised of two real poles (with one at
zero frequency, the integral term) and two zeros, which are not necessarily
real. Comparing this with the `dominant pole plus lead' compensator transfer
function, we see the same pole/zero features except that the `dominant pole
plus lead' compensator has real valued zeros.

7.3 Tasks

7.3.1 Pre-Lab

1. Design of feedback compensator: Design a `dominant pole plus lead'
compensator for the system. The compensator should achieve a phase
margin ≥ 45◦ and gain margin ≥ 10 dB. The loop gain bandwidth (i.e.
the unity gain crossover frequency) should be set at 1

8 of the switching

frequency, i.e. 40 kHz
8 = 5 kHz. Note that use of this compensator, which

features a pole at zero, assures a performance characteristic of zero steady
state error to step inputs. Fully document your design procedure.

Use the asymptotic Bode plot method to design your compensator. This
methodology involves using asymptotic Bode plot construction of the
desired loop gain from which simpli�ed equations may be derived for use
in the design process. It does not inherently rely on trial and error
iteration and so you are requested not to use such an approach. In the
text by Tymerski & Rytkonen the methodology is discussed for the
suggested compensator for the buck regulator in a section entitled
�Dominant Pole with Lead Compensation�. There are two design
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variations discussed there; one being better than the other. (So choose
wisely).
Determine the compensator parameters from simpli�ed equations derived
from your asymptotic plots. As a �nal step in the design, implement the
compensator as a circuit. The needed equations for this are given above.
For the model of the PWM modulator use a peak-to-peak ramp
amplitude value that you measured in Lab. 4. Clearly note this value in
your report.

2. Compensator design veri�cation: With the compensator design com-
pleted in Task (1) we will now verify the design before implementing it in
the lab. This veri�cation is similar to that previously done in Lab. 5 for
a di�erent compensator. The Matlab code developed there can be reused
here.

In the following tasks we will analyze the closed-loop system using Matlab
and PECS.

Closed-loop transfer functions - Matlab:

(a) Loop gain: Determine the loop gain transfer function and use the
Matlab margin command to obtain the Bode plot of this loop gain.
Have the plot display frequency in Hz. The command will also obtain
the unity gain crossover and −180◦ phase crossover frequencies and
the phase and gain margins of the system. Make note of these in
your report.

(b) Input voltage to output voltage: Determine the closed-loop in-
put source voltage to output voltage transfer function which we'll
denote as: Gvg_CL.Use the Matlab bodemag command to obtain the
magnitude frequency response of this transfer function. On the same
plot show the open loop transfer function, Gvg. Display frequency in
Hz over a range of 1 Hz to 10 kHz.

(c) Output current to output voltage: Determine the closed-loop
output current to output voltage transfer function. Since this is the
negative of the output impedance, we will denote it as −Zout_CL. Use
the Matlab bodemag command to obtain the magnitude frequency
response of this transfer function. On the same plot show the open
loop transfer function, −Zout. Display frequency in Hz over a range
of 1 Hz to 10 kHz.

3. Closed-loop simulations � Matlab:

Note that the following simulations obtained using Matlab are based on
the small-signal model. The DC conditions and large signal e�ects are not
modelled and consequently do not show up in the simulations.
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(a) Input voltage step response: Use the transfer function obtained
above for Gvg_CL to obtain the step response for the 10% input
voltage step. As the nominal input voltage 10 V, this implies a unit
step change. If required, refer to Lab 3 to see how to use the Matlab
lsim command to perform step response simulation. As shown in
Lab 3 add the steady state average voltage to this simulation so as to
ease the comparison with the PECS simulation to follow. Obtain the
step response plot and determine the maximum peak-to-peak output
voltage deviation, ∆v, and steady state error, SSE.

(b) Output current step response: Use the transfer function ob-
tained above for −Zout_CL to obtain the step response for a step
load change. If required, refer to Lab. 3 to see how to determine
the current load step value and to see how it can be used with the
Matlab lsim command to perform step response simulation. As with
the input voltage step simulation add the average output voltage to
the simulation to simplify the comparison with the PECS simulation
which follows. Obtain the step response plot and determine the max-
imum peak-to-peak output voltage deviation, ∆v, and steady state
error, SSE.

4. Closed-loop simulations � PECS:

We will now use the circuit simulator to obtain the same two closed loop
responses discussed in task 3 above. The PECS simulations will show DC
conditions and large signal e�ects, such as ripple, not available using the
Matlab small-signal models.

(a) Input voltage step response: Con�gure a PECS schematic to
obtain the input voltage step response to steps from 10 V to 11 V
back to 10 V, as done in previous labs. Obtain the step response plot
and determine the maximum peak-to-peak output voltage deviation,
∆v, and steady state error, SSE.

(b) Output current step response: Con�gure a PECS schematic to
obtain the output voltage response for step load changes from 25 Ω
to 5 Ω back to 25 Ω. Obtain the step response plot and determine
the maximum peak-to-peak output voltage deviation, ∆v, and steady
state error, SSE.

7.3.2 In the Lab

Now that you've con�rmed your design with both Matlab and PECS, we
can con�dently build the circuit.

5. Build and test the new compensator:



62 CHAPTER 7. LAB 6

(a) Add new compensator: Replace the integral compensator of Lab
5 with your newly designed compensator and con�rm that the circuit
is functioning properly with this compensator. Check that the output
is at a constant 5 V level. Do not operate load switching at this time.

(b) Output current step response: Apply the load switching signal
and observe the output voltage response. Adjust the frequency of
load switching, if necessary. Take a screen shot of the output volt-
age response. Determine the maximum peak-to-peak output voltage
deviation, ∆v, and steady state error, SSE.

7.3.3 Post-Lab

Results:

6. In your report include the following tables to succinctly summarize your
results.

(a) In the following table, summarize results of your loop design obtained
by

i. the asymptotic Bode plot method, and,

ii. Matlab con�rmation

Phase Margin
φPM

(degrees)

Unity Gain
Crossover, fc

(kHz)

Gain Margin
GGM

(dB)

Phase
Crossover, fGM

(kHz)
i) Asymptotes
ii) Matlab

(b) Summarize the performance of your design. We will also take the
opportunity to compare the results with those obtained from previous
labs.

Three implementations will be compared:

i. Open loop (Lab 4)

ii. Closed loop with integral compensation (Lab. 5)

iii. Closed loop with `dominant pole plus lead' compensation (Lab.
6, this lab)

The results will be summarized by completing the following table:

φPM : phase margin obtained from Matlab margin command

fc: unity gain crossover frequency obtained from Matlab margin
command

∆v: maximum peak-to-peak output voltage variation, result may
be obtained from the LAB, PECS or MATLAB.

SSE : steady state error voltage result obtained from the LAB,
PECS or MATLAB.
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Open loop*
(Uncompenstated)
(from Lab. 4)

Integral
Compensator,
(from Lab. 5)

Integral + lead
Compensator,

(from Lab. 6, this lab)

Compensator
Transfer
Function
Gc(s)

No compensator

φPM (degrees)
MATLAB
fc (kHz)
MATLAB

iout step: ∆v (mV)
LAB

iout step: ∆v (mV)
PECS

iout step: ∆v (mV)
MATLAB

iout step: SSE (mV)
LAB

iout step: SSE (mV)
PECS

iout step: SSE (mV)
MATLAB

vg step: ∆v (mV)
PECS

vg step: ∆v (mV)
MATLAB

vg step: SSE (mV)
PECS

vg step: SSE (mV)
MATLAB

*This is the open loop (uncompensated) system. That is, unlike the
other two systems feedback is not applied. It is included here to see
how well feedback control is able to improve on open loop control.

(c) Write your observations concerning these results.
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No. Item
C1 100 µF capacitor

electrolytic
C2 100 µF capacitor

Kemet A758EK107M1AAAE016
C3 10 nF capacitor
C4 3.3 nF capacitor
C5 1 µF capacitor
C6 1 µF capacitor
C7 1 µF capacitor
C8 1 µF capacitor
C9 22 nF capacitor
D1 Power Schottky Diode

Sanken RA 13V1
D2 1N5222 2.5 V Zener Diode
D3 1N5222 2.5 V Zener Diode
L1 560 µH inductor

Bourns Inc. 2200HT-561-V-RC
R1 1 kΩ 1

16 W Resistor
R2 5 Ω 5 W Power Resistor
R3 20 Ω 2 W Power Resistor
R4 47 Ω 1

16 W Resistor
R5 2.7 kΩ 1

16 W Resistor
R6 560 Ω 1

16 W Resistor
R7 4.7 kΩ 1

16 W Resistor
R8 3.3 kΩ 1

16 W Resistor
R9 220 kΩ 1

16 W Resistor
R10 12 kΩ 1

16 W Resistor
R11 100 kΩ 1

16 W Resistor
R15 1 kΩ 1

16 W Resistor
R16 1 kΩ 1

16 W Resistor
Q1 Q2N2222 NPN Transistor
Q2 Q2N2907 PNP Transistor
Q3 IRF 9530 P-Channel MOSFET
Q4 IRF 530 N-Channel MOSFET
Q5 Q2N2907 PNP Transistor
U1 LM555 Timer
VR1 10kΩ Variable Resistor
VR2 1kΩ Variable Resistor
X1 LM311 Voltage Comparator
X2 CA3140 Op Amp
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PECS

Power Electronics Circuit Simulator

B.1 PECS Overall Description

PECS is a circuit simulator which features high simulation accuracy as well as
fast simulation times. It is particularly well suited to circuits which contain
ideal switches, as is the case with power electronic circuits. It was developed at
Portland State University [1], [2], [3].

The PECS software actually consists of two distinct programs:

1. PECS, provides graphical schematic capture and simulation functions. At
the end of a successful simulation run an output �le is written to the hard
drive.

2. PECSPLOT, provides plotting and graphical post processing of selected
outputs designated in the PECS schematic. A �le previously written to the
hard drive is read by this program. Note that PECSPLOT is automatically
called by the PECS program at the end of a simulation and, as such, the
user need not call this program directly. However, a user may use this
program directly if so desired on a previously stored PECS output �le.

Figure B.1 shows the PECS user interface with a displayed circuit schematic.
PECSPLOT is discussed more fully in the next section..

B.2 PECS Usage

The following steps are taken to simulate a circuit and produce an output plot:

1. Build the desired circuit schematic in PECS.

67
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Figure B.1: The PECS program showing a circuit schematic.

2. Set simulation parameters.

3. Run the simulation.

4. Select the desired output(s) to plot.

These will be expanded on next:

B.2.1 Building a circuit schematic in PECS

Element selection: Select the desired component to place from the component
selection bar at the bottom by left mouse clicking on the element or from the
Element menu at the top. Drag the element to the appropriate position on the
page and then left click again to place it. This action will also bring up another
copy of the element which may subsequently also be placed. Clicking the right
button will eliminate the copy (or the original selected component) if not needed.

Component Rotation: Rotation of components in 90 degree clockwise
increments can be achieved by pressing the space bar on the keyboard.

Wiring between components: Connections between components is made
by �rst left clicking on the wire icon available in both the bottom component
selection bar and in the top menu bar of PECS. This action causes the mouse
cursor to change to a pen shape. Vertical and/or horizontal lines can now be
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drawn between element nodes to connect them. Note that only connections be-
tween nodes of an element will constitute a valid connection. To exit this mode
of operation one can either right click the mouse or left click on the arrow icon
in the top menu icon bar.

Selection of previously placed components: After a component has
been placed in the schematic it can be selected by either left clicking on it or
by depressing the left mouse button in the vicinity of the component and then,
with the left button depressed, dragging the mouse over the component which
will bring up a rectangle. Releasing the button will select any component which
was fully enclosed in the rectangular area. The selected components will now
appear in red.

Movement of previously placed components: First select components
to be moved using the procedure discussed immediately above. These selected
components may now be moved by depressing the left button on any of the se-
lected components and, while depressed, dragging to the new desired position.
After the components have been moved, deselect them as discussed next.

Deselection of components: Previously selected components can be de-
selected by either right clicking the mouse or left clicking anywhere away from
the area occupied by the selected components.

Deletion of selected components: A component or a number of com-
ponents can be simultaneously deleted from a schematic by �rst selecting them
and then right clicking on the scissors icon in the top component icon bar or
pressing the Delete button on the keyboard.

Outputs: Output variables to be plotted can be any voltage or current in
the schematic. These are identi�ed in the schematic by an appropriately place
voltage port element or a current port element. A voltage port is placed in paral-
lel across the two points in the schematic for which the voltage will output. On
the other hand a current port is placed in series with line in which the current
will be monitored.

Ground node: PECS requires that a ground node be placed in the circuit.
This is the left most icon in the bottom element icon bar. Output ports: PECS
requires that at least one voltage or current port appear in the circuit. Ports
indicate to PECS which variables are to be stored for latter plotting.

Components available: The following are the most used components
available in PECS. (This does not cover the complete set of components avail-
able in PECS).

� Basic passive elements: R (resistor), C (capacitor) and L (inductor)

� Sources: VDC (DC voltage), IDC (DC current), VAC (AC voltage)
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� Ports: Vport (voltage port) and Iport (current port)

� Switches: Sw (controlled switch) and D (diode)

� Switch control elements: Clk (Clock) and (MOD) PWM Modulator

� Miscellaneous: OPAMP (operational ampli�er), current sensor (no symbol
name), ground node (no symbol name) and wire (no symbol name)

These available components will be further discussed in greater detail be-
low. There are range of other components that PECS features, such the four
controlled sources, but these will not be discussed here as they will not be used.

Assigning component parameter values: Any time after a component
has been placed it may be assigned with speci�c values. Double left clicking on
the placed component will bring up the component dialog window. Note that
PECS will not run a simulation if any component values haven't been adequately
assigned. An error message will be given alerting to this fact and unassigned
components will be highlighted in red. There is no need to specify component
names as these are automatically assigned.

Saving a schematic: A schematic can be saved to disk at any time. A
default name of Untitled.ckt is assigned and so a more appropriate named should
be substituted. Note that during the construction/editing of a schematic, PECS
periodically saves a backup �le which is given the name backup.ckt. If need be,
this �le can be read back into PECS by using the File → Open ... menu item.

B.2.2 Setting simulation parameters

Before a simulation is run, appropriate simulation parameters should be as-
signed. This is achieved by bringing up the appropriate dialog window through
the menu item Simulation → Parameters ... . This dialog window appears as
shown in Figure B.2.

The simulation parameters are:

i Final Time: the total length of time of the simulation.

ii Step Size: this should be increased/decreased to decrease/increase, re-
spectively, the number of points at which the response will be determined.
It is important to use a small enough value here so as to smoothen the
output. Note that plotting between response points is achieved by using
straight line segments. The points in time in the simulation interval that
are actually saved to hard disk is speci�ed by the Save interval parameters:

iii Start time: this is the time from which the output is saved to disk.

iv End time: this is the time to which the output is saved to disk. Generally
this should be the same as the simulation �nal time.
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Figure B.2: Simulation parameters dialog window showing the default values.

v # of points: This speci�es the number of evenly-spaced points that are
saved in the save interval. This value rarely needs to be changed from
its default as generally it is best to maximize the number of points saved
which will lead to a smoother looking plot.

B.2.3 Running the simulation

After the above two steps have been completed, one can run the simulation by
left clicking on the script R icon in the top icon bar. Alternatively, this can be
initiated through the menu by selecting Simulation → Run.

Assuming the schematic has been constituted properly the simulation will
start and a progress bar at the bottom of PECS will appear. At the end of
the simulation a dialog window appears indicating the total real time used to
perform the simulation. When this dialog is dismissed PECSPLOT will auto-
matically be called.

B.2.4 Selecting the desired output(s) to plot

When PECSPLOT appears a number of outputs will appear in the left column.
These output having previously been speci�ed by the voltage and current ports
in the PECS schematic. Moving the output port names from the left to the right
column speci�es the plot to be viewed. This is achieved by double clicking the
left mouse button on the selected output variable. Alternatively, one can move
an output variable from the left column by selecting it (or a number of outputs)
and then left clicking on the Add button between the columns. Any number
of output variables can be displayed in one plot but generally it is best that
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di�erent variables appear in their own plot so as to the accommodate scaling
for the plot, which is automatic. This is achieved by using the Add menu item
in PECSPLPOT.
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B.3 Elements

B.3.1 Basic passive elements: R (resistor), C (capacitor)
and L (inductor)

Resistor:
The schematic symbol of a resistor is shown in Figure B.3. The resistance value
is the only parameter value that needs to be speci�ed the dialog window shown
in Figure B.4.

Figure B.3: Resistor schematic symbol

Figure B.4: Resistor dialog window

Capacitor:
The schematic symbol of a capacitor is shown in Figure B.5. The capacitor
value and an initial voltage are the parameters that need to be speci�ed in the
dialog window shown in Figure B.6.

Figure B.5: Capacitor schematic symbol
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Figure B.6: Capacitor dialog window

Inductor:
The schematic symbol of an inductor is shown in Figure B.7. The inductor
value and an initial current are the parameters that need to be speci�ed in the
dialog window shown in Figure B.8.

Figure B.7: Inductor schematic symbol

Figure B.8: Inductor dialog window

B.3.2 Sources: VDC (DC voltage), IDC (DC current),
VAC (AC voltage)

DC Voltage Source:
The schematic symbol of a DC voltage source is shown in Figure B.9. The value
of the voltage is a user speci�ed parameter that is entered in the dialog window,
shown in Figure B.10.

Figure B.9: DC Voltage Source schematic symbol
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Figure B.10: DC Voltage Source

Voltage sources can be stepped in value at a limited number of user speci�ed
times. Clicking on the Steps button will open the bottom section of the dialog
window where one is able to enter up to �ve time and associated step values
which the voltage source will assume during the simulation. This is shown in
Figure B.11. If step values are present, the dialog window will appear fully
expanded on initiation.

Figure B.11: DC Voltage Source, showing voltage step times and values

DC Current Source:
The schematic symbol of a DC current source is shown in Figure B.12. The
value of the current is a user speci�ed parameter that is entered in the dialog
window, shown in Figure B.13.

Figure B.12: DC Current Source schematic symbol
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Figure B.13: DC Current Source dialog window

Current sources can be stepped in value at a limited number of user speci�ed
times. Clicking on the Steps button will open the bottom section of the dialog
window where one is able to enter up to �ve time and associated step values
which the current source will assume during the simulation. This is shown in
Figure B.14. If step values are present, the dialog window will appear fully
expanded on initiation.

Figure B.14: DC Current Source dialog window, showing voltage step times and
values

AC Voltage Source:
The schematic symbol of an AC voltage source is shown in Figure B.15. This
element produces a sinusoidal voltage waveform. The peak amplitude (volts),
frequency (Hz) and phase (degrees) comprise the parameters that are entered
into the dialog window, see Figure B.16, which will specify its characteristics.

Figure B.15: AC Voltage Source schematic symbol
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Figure B.16: AC Voltage Source dialog window

B.3.3 Ports: Vport (voltage port) and Iport (current port)

Voltage Port:
The schematic symbol of a voltage port is shown in Figure B.17. The purpose
of voltage port is to monitor the voltage across two points in the circuit being
simulated. This voltage will be saved in the output �le which will be read by the
plotting program. There are no parameters required for this element, however
as with most of the other elements the name may be changed from its default
via the dialog window, see Figure B.18.

Figure B.17: Voltage port schematic symbol

Figure B.18: Voltage Port dialog window

Current Port:
The schematic symbol of a current port is shown in Figure B.19. The purpose
of a current port is to monitor the current in a branch in the circuit being
simulated. This current will be saved in the output �le which will be read
by the plotting program. There are no parameters required for this element,
however as with most of the other elements the name may be changed from its
default via the dialog window, see Figure B.20.
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Figure B.19: Current Port schematic symbol

Figure B.20: Current Port dialog window

B.3.4 Switches: Sw (controlled switch) and D (diode)

Switch:
The schematic symbol for a switch is shown in Figure B.21.

Figure B.21: Switch schematic symbol

A switch features two electrical terminals and two control terminals which
are labeled ON and OFF. The connection to the control terminals is not electri-
cal. Only speci�c switch control elements may be connected to these terminals.
The switch control elements that are discussed here are:

1. Clock

2. PWM Modulator

Note that once a switch turns ON or OFF by the (conceptual) impulses driv-
ing it, it remains in this state until the time instant of a counter-acting control
signal.

Double clicking on the switch symbol will bring up the dialog window which
is shown in Figure B.22. An initial state can be selected and is provided to
de�ne the starting point for a cycle for use in the accelerated steady state
determination feature available in PECS. (This feature is not discussed here.)
If the selected initial state is not correct, the program will alter the state.
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Figure B.22: Switch dialog window

Diode:
The schematic symbol of a diode is shown in Figure B.23, with the dialog window
shown in Figure B.24. As with the switch element, there is facility to stipulate
the initial state of the diode which is used to de�ne the starting state at the
beginning of a switching cycle. Should this state be incompatible with current
circuit conditions the simulator will change the diode state.

Figure B.23: Diode schematic symbol

Figure B.24: Diode dialog window

B.3.5 Switch control elements: Clk (Clock) and (MOD)
PWM Modulator

Clock:
The schematic symbol for a clock is shown in Figure B.25.
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Figure B.25: Clock schematic symbol

A clock has only one terminal which can only be connected to a switch ON
or OFF node. The parameters of a clock element are:

1. Delay time

2. Period

With reference to Figure B.26, we see that after an initial delay of Delay
seconds the switch is then turned ON (OFF). Following this initial signal, sub-
sequent signals are issued every Period seconds. Thus, if the clock element is
connected to the ON (OFF) terminal of the switch, these subsequent signals
repeatedly turn the switch ON (OFF).

The Delay and Period parameters are entered into the dialog window as seen
in Figure B.27.

Figure B.26: Delay and period parameters shown pictorially

Figure B.27: Clock dialog window

Pulse Width Modulator:
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Figure B.28: Pulse Width Modulator schematic symbol

The schematic symbol of a PWM modulator is shown in Figure B.28. This
symbol pictorially shows a four input comparator and a sawtooth generator.
Whenever the sum of the four inputs (three are added and one is subtracted)
becomes negative, the output (which can only be connected to a switch control
terminal) will issue an appropriate turn ON or OFF signal. Two external inputs
are provided to the modulator. These inputs are fed through gain blocks K1

and K2 The third input to the comparator is a constant K3. K1, K2 and K3 are
all input parameters of the modulator element. The last comparator input is
from a (conceptual) sawtooth generator where the peak-to-peak voltage ampli-
tude, Vpk−pk, period of the sawtooth are the �nal two parameters of this element.

If we consider signals K1 and K2 to be connected to the K1 and K2 in-
puts, respectively, then an output switching signal is issued from the modulator
whenever

K1 · v1 +K2 · v2 +K3 − VRAMP < 0

The PWM dialog window is shown in Figure B.29 where the input gains,
K1, K2 and K3, and sawtooth parameters, the peak to peak voltage (Vpkpk and
period can be entered.
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Figure B.29: Pulse Width Modulator dialog window

B.3.6 Miscellaneous: OPAMP (operational ampli�er), cur-
rent sensor (no symbol name), ground node (no
symbol name)

Operational Ampli�er:
The schematic symbol of an op-amp is shown in Figure B.30.

Figure B.30: Operational Ampli�er schematic symbol

The model of the op-amp used in PECS is shown in Figure B.31. There
are three parameters that characterize this model: 1) input resistance, Ri, 2)
output resistance, Ro, and 3) op-amp gain. The values of these parameters
can be changed via the element dialog window which is shown in Figure B.32.
Generally the default values will need not be changed.

Figure B.31: (a) Op-amp, and (b) its corresponding model
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Figure B.32: Operational Ampli�er dialog window, showing the default param-
eter values.

Current sensor:
The schematic symbol for a current sensor element is shown in Figure B.33.
There are no user de�ned parameters for this device and so there is no associated
dialog window.

Figure B.33: Current sensor schematic symbol

Ground node:
The schematic symbol for a ground node element is shown in Figure B.34. There
are no user de�ned parameters for this device and so there is no associated dialog
window.

Figure B.34: Ground node schematic symbol
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B.4 PECSPLOT

This section provides a comprehensive overview of PECSLOT, which is the pro-
gram that PECS calls to plot the waveforms that were generated by simulation
in PECS. PECSPLOT is automatically called by PECS at the end of a simu-
lation. However, it may also be user initiated which subsequently requires the
user to choose the desired data �le (which has extension *.plt) which contains
the waveform data.

PECSPLOT has the following features:

1. Multiple plots, stacked vertically, are possible.

2. Multiple waveforms can appear in each plot.

3. Zooming into a desired time interval is possible.

4. Accurate measurements of time and amplitude are possible.

5. Auto-scaling of the amplitude axis for single and multiple waveform plots.

6. Full customization of font size, waveform and background colors is pro-
vided.

B.5 Terminology:

1. Waveform - a signal that is shown within a plot. Multiple waveforms can
be shown within the same plot. Necessarily all waveforms share the same
scaling of the vertical axis.

2. Plot - A time and amplitude axis pair within which waveforms appear.
Waveforms of widely di�ering amplitudes are best graphed in separate
plots with their own individual vertical scaling.

To illustrate these terms, let us consider Figure B.35 which shows PEC-
SPLOT displaying a number of waveforms. Speci�cally there are two plots.
The top plot shows the waveforms VP1 in red and VP2 in green. The bottom
plot shows only the VP2 waveform. Because the scaling in the top plot is dom-
inated by the amplitude of the VP1 waveform not much detail can be seen for
the VP2 waveform. However, this detail is available in the bottom plot where
the vertical scaling accommodates for the amplitude of the VP2 alone.

B.6 General use

Before delving into the functionality o�ered by PECSPLOT under the di�erent
menu items, we'll �rst look at the overall general use.
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After PECS completes a simulation it stores the data points to the hard drive
and subsequently calls PECSPLOT which reads the �le. The waveform names
are then displayed to the user who then selects how they are to be plotted, that
is, the number of plots desired and the grouping of waveforms. This waveform
selection dialog window is shown in Figure B.36.

Figure B.35: PECSPLOT displaying two plots. The top plot show two wave-
forms and the bottom show only one.

B.7 Menu items

As seen in Figure B.35 the following menu items appear across the top of the
application:

1. File menu

2. Edit menu

3. Plots menu

4. View menu

5. Options menu

6. Help menu



86 APPENDIX B. PECS

The functionality provided under each of these menu items will be presented
next.

B.7.1 File menu commands

The File menu o�ers the following commands:

1. Open: Opens a PECSPLOT �le.

2. Reload: Reloads an opened PECSPLOT �le.

3. Save: Saves an opened PECSPLOT �le using the same �le name. Only
currently displayed waveforms will be saved, other waveforms appearing
in the �le will be deleted.

4. Save As: Saves a PECSPLOT �le to a speci�ed �le name.

5. Print: Prints the currently displayed plot(s).

6. Print Preview: Displays the current plot(s) seen on the screen as it would
appear printed.

7. Print Setup: Selects a printer and printer connection.

8. Exit: Exits PECSPLOT

Figure B.36: Selection of waveforms dialog window.
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B.7.2 Edit menu commands

The Edit menu o�ers the following commands:

1. Copy to Clipboard: Copies data from the currently displayed plot(s) to
the clipboard.

2. Edit Title: Two captions that appear on the top left and top right positions
of the printout may be edited. The default are the PECSPLOT �le name
(top left) and the current date and time (top right).

B.7.3 Plots Menu commands

The Plots menu o�ers the following commands:

1. Add/Delete Waveform: Add or delete a waveform to the chosen plot.

2. Add Plot: Add an extra plot.

3. Delete Plot: Delete a plot.

4. Measure: Enable measurement of displayed waveforms.

5. Max: Show the maximum value of all waveforms (as well as the times at
which they occur) in the chosen plot. Measure mode must �rst be chosen
to un-gray this menu item.

6. Min: Show the minimum value of all waveforms (as well as the time at
which they occur) in the chosen plot. Measure mode must �rst be chosen
to un-gray this menu item.

Selecting the Plots → Measuremenu item (or alternatively clicking on the
calipers icon in the icon bar) will bring up the measurement display screen as
shown in Figure B.37. Measurement is undertaken by �rst left and/or right
clicking inside a plot at the desired position(s). Accurate placement of the mea-
surement lines may be obtained using the left and right keyboard arrow keys.
This a�ects movement of the measurement lines on a data point by point basis.

Waveforms may be manipulated mathematically. This is done through the
waveform selection dialog which was shown in Figure B.36. The following op-
erators may be used: +, -, *, /, and ^ where '^' refers to exponentiation. The
following functions are provided: sin, cos, tan, sqrt, fabs, exp,atan, log and log10.
These functions use the standard C language implementations. Each requires
a single argument and caution should be exercised for the range of values that
the functions will see as some functions may not be de�ned for some range of
values. For example, sqrt, log and log10 are not de�ned for negative values.
The constant pi (= 3.141592654) is recognized. Also engineering su�xes may
be used and are listed in Table B.1.
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Table B.1: Su�xes and corresponding values.

Su�x M k m u n p
Value 1E+6 1E+3 1E-3 1E-6 1E-9 1E-12

For example, 10k = 10,000. Be sure not to use any waveform names that
correspond to these su�xes.

Any level of parenthetical expression with "(" and ")" may be used. An
example of a valid expression is:

(I(L2)+sin(2*pi*10k*vo))-1, where "I(L2)" and "vo" are valid waveform
names.

Figure B.37: The measure display dialog usually appears at the lower left corner
of the computer screen. Here it has been moved to the position shown for display
purposes. Clicking the left and right mouse buttons in the bottom plot area at
the appropriate positions results in the vertical lines appearing and the value of
the waveform(s), as well as the time values, being displayed. The third column
indicates the di�erence between the two values, which in this case results in a
measurement of the peak-to-peak amplitude of the displayed waveform.
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B.7.4 View menu commands

The View menu o�ers the following commands:

1. Zoom: Zooms in on the x-axis limits. These limits are established by
the user left clicking inside a plot and then dragging to another position.
Only the x values of the initial and �nal positions are used. The y-axis
limits of the zoomed plot(s) are automatically scaled commensurate with
the currently displayed waveforms in the selected x value range.

2. Zoom All: Use maximum x-axis limits given by the data in the PEC-
SPLOT �le.

3. Redraw: Redraw without altering the zoom factor (if any).

4. Toolbar: Shows or hides the toolbar.

5. Status Bar: Shows or hides the status bar.

B.7.5 Options menu commands

The Options menu o�ers the following commands, which enable you to cus-
tomize the plots appearance:

1. Text Settings: Change the font style, font size, font color.

2. Background Color: Change the background color.

3. Waveform Color: Change individual waveform colors. To un-gray this
menu item, �rst select a waveform by left clicking on a waveform title from
those appearing above each plot. Note that all plots using the selected
waveform color will be changed to the new color.

4. Grid: Toggle grid on or o�.

B.7.6 Help menu commands

The Help menu o�ers the following commands, which provide assistance with
PECSPLOT:

1. Index: O�ers an index to topics on which help can be obtained.

2. About: Displays the version number of PECSPLOT as well as contact
information.
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